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Copyright notice  

©Delta Electronics, Inc. All rights reserved. 

All information contained in this user manual is the exclusive property of Delta 

Electronics Inc. (hereinafter referred to as "Delta") and is protected by 

copyright law and all other laws. Delta retains the exclusive rights of this user 

manual in accordance with the copyright law and all other laws. No parts in 

this manual may be reproduced, transmitted, transcribed, translated or used 

in any other ways without the prior consent of Delta.  

 

Limitation of Liability  

The contents of this user manual are only for the use of the DIAStudio 

manufactured by Delta. Except as defined in special mandatory laws, Delta 

provides this user manual “as is” and does not offer any kind of warranty 

through this user manual for using the product, either express or implied, 

including but not limited to the following: 

(i) this product will meet your needs or expectations; 

(ii) the information contained in the product is current and correct;  

(iii) the product does not infringe any rights of any other person. Use the 

product at your own risk. 

In no event shall Delta, its subsidiaries, affiliates, managers, employees, 

agents, partners and licensors be liable for any direct, indirect, incidental, 

special, derivative or consequential damages (including but not limited to the 

damages for loss of profits, goodwill, use or other intangible losses) unless 

the laws contains special mandatory provisions to the contrary. 

Delta reserves the right to make changes to the user manual and the products 

described in the user manual without prior notice and afterwards. 

 

EPLAN Information 

EPLAN provides software and service solutions in the field of electrical, 

automation and mechatronic engineering. The company develops one of the 
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world’s leading design software solutions for machine and panel builders. 

Both standardised as well as customised interfaces to ERP and PLM/PDM 

systems ensure data consistency along the whole value chain. EPLAN was 

founded in 1984 and is part of the owner-operated Friedhelm Loh Group. 
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1.1 DIAStudio Integrated Engineering Software 

DIAStudio is an all-in-one integrated engineering platform, on which users can 

efficiently develop machinery systems, from product selection, programming, 

to exporting. 

It simplifies the process, and helps to save time and cost for building 

machinery systems. 

Figure 1 - 1: DIAStudio Features 

1.1.1 Key Software 

The DIAStudio comprises of 6 key software: 

• DIASelector: quick, easy, smart selection tool.

• DIADesigner: Integrated development & engineering software.

• DIAScreen: Intuitive visualization software.

• DIAInstaller: System installation & update management

• COMMGR: Communication management

• DIADesigner-AX: Motion development and engineering software

The DIAStudio supports efficient and flexible data transmission between 

software. It also facilitates for tag sharing between software. 
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1.2 Introduction 
 

The DIASelector (Delta Industrial Automation Selector) application assists 

user to select Delta’s Industrial Automation products based on associated 

technical requirements. 

 

User can compare the products based on properties and specifications, 

configure products to create a complete system and export the result in the 

form of BOM.  

 

The project file created with DIASelector can be exported to EPLAN for 

cabinet designing.  

DIASelector application is part of DIAStudio suite and is available in multiple 

variants as follows:  

• Stand-alone windows desktop application.  

• Mobile application (Android).  

 

1.3 Key Features 
 

The key features of DIASelector are: 

• Product selection  

• Product filter  

• Product compare  

• Product search, based on Part number, Description and Part number 

Pattern.  

• Compatible accessories recommendation.  

• Configure PLC, AC Motor Drives and AC Servo Drives.  

• View product properties, product images, descriptions and so on.  
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• Generate BOM for added products and export it in MS-Word/Excel file 

format. Same can be send via e-mail also.  

• Open/Save project on local hard disk or from/to Delta Cloud 

(DIAStudio-Web).  

• Download and view the product catalogs.  

• Share project with other registered DIAStudio users.  

• Supports English, Traditional Chinese and Simplified Chinese 

languages.  

• Provides support for any Technical query.  

 

1.4 DIASelector Process Flowchart 
 

 

Figure 1 - 2: DIASelector 
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Chapter 2: Getting Started 
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2.1 Hardware and Software Requirements 
 

2.1.1 Desktop Requirements 
 

Item System Requirement 

 Operating System Windows 7 / 8.1 / 10 Server 2012 R2 32/64 bits 

 CPU Intel Celeron 540 1.8GHz (min.) , Intel Core i5 M520 
2.4 GHz (min.) 

 Memory 2GB or above (recommend to use 4GB or above) 

 Hard Disk Drive 10GB or above 

 Monitor Resolution: 1024 x 768 Pixels, 1920 x 1080 Pixels 

 Keyboard/Mouse General Keyboard Mouse or Windows compatible 
device 

 Printer Printer with Windows driver (optional for printing of 
project content) 

 USB Used in Connection with the 
device 

According to the 
communication 
interface provided by 
the device  Ethernet Used in Connection with the 

device 
 Software Need to install .Net Framework 4.6.2 
 

2.1.2 Mobile Requirements 
 

Supported Devices: Mobile Phone and Tab  

Operating System: Lollipop and above (min API level 21) 

 

2.1.3 Installation Procedure 
 

Ensure that the host computer follows the minimum criteria mentioned in the 

section 2.1.1 Desktop Requirements and the DIAInstaller is operating on it. 
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The DIAInstaller is a resident program to manage all Delta IA software. User 

can check for download, install and update for Delta IA software in 

DIAInstaller with minimum effort, and everything will be handle in background. 

DIAStudio software download and installation tools can be download from 

below website: 

https://diastudio.deltaww.com/home/downloads?sec=download 

Refer Software Download Manual to install DIASelector application. 

 

2.2 Product Database Update 
 

The Product Database Update feature allows user to synchronize the local 

database with master database. This function can be accessed through 

Option > Update Product Database. The Product Database update 

window is as shown in the figure: 

 

 

Figure 2 - 1: Product Database Update 

 

Legend Name 

1 Frequency 

https://diastudio.deltaww.com/home/downloads?sec=download
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Legend Name 

2 Product Library Recent Updates 

3 Product 

 

Frequency: It allows users to set the notification frequency for product 

updates in the database. Select either Auto, Daily, Weekly or Monthly. 

Product Library Updates: It provides the list of recently updated products in 

the database. It displays maximum of 5 recent product updates. 

Product: It allows users to update product database. Select either Update all 
products or New Updates available. 

 

 

Figure 2 - 2: Product Database Update 

 

NOTE:  When the product database update is in-progress, click on the 

Cancel to cancel the update and restores the old database. 
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2.2.1 Product Database Update Scenarios 
 

The product database can be updated in different scenarios as mentioned in 

the following sections, 

 

Product Database update after the first launch: 

 

The Product Database update window appears automatically after the first 

launch of the DIASelector application.  

Select the required frequency and product update range. Then, click on Start 
button to update the Product database. 

NOTE: It notifies as Product Database Updated, once database update is 

complete. 

 

Product Database Update manually: 

 

User can update the Product Database manually anytime by clicking on 

Option > Update Product Database as shown in the figure. 

 

 

Figure 2 - 3: Update Product Database 

 

Product Database update while working on a project: 

 

The product database can be updated while working on a project.  
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Click on the Option > Update Product Database. The pop-up window 

displays as shown in the figure.  

 

 

Figure 2 - 4: Database Update while working on a Project 

 

If user clicks Yes, the changes made to the project is saved, and the project is 

closed for the database update. 

Or 

If user clicks No, the changes made to the project is ignored, and the project 

is closed for the database update. 

Or 

If user clicks Cancel, the product database update is cancelled. 

 

NOTE: The project closes automatically for database update. 

 

Product Database update with saved project: 

 

The product database can be updated for the projects which are created and 

saved. 

Open a project, click on Option > Update Product Database. The pop-up 

window displays as shown in the figure. 
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Figure 2 - 5: Database Update for Saved Project 

 

Click on OK button, the project closes automatically for database update. 

 

2.3 Sign In 
 

 

Figure 2 - 6: Sign In 

 

The DIAStudio account allows user to access multiple software systems 

within DIAStudio ecosystem. With this Single Sign-On, users can log in with a 

single ID and password to gain access to a connected system without using 

different accounts. 

User can access DIAStudio website through https://diastudio.deltaww.com. 

NOTE: Click on the sign-in name on the top-right corner of the window, the 

details of login and Sign Out option is displayed as shown in the figure. 

 

 

https://diastudio.deltaww.com/
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Figure 2 - 7: Sign In Details 
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Chapter 3: DIASelector Welcome Screen 
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3.1 Introduction 
 

The home screen of DIASelector has the options to access the different 

functions related to product selection and specific device configuration. 

 

 

Figure 3 - 1: DIASelector Main Window 

 

Legend Name 

1 Application window title bar 

2 Menu bar 

3 Quick access tool bar 

4 Project View 

5 Sign In 

6 Properties, Product Search, Filter 

7 Selection View  

8 System  
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3.2 Menu bar 
 

The menu bar displays the menu options. 

 

Menu Name 

 
 

File menu allows to  
• Create a new project  
• Open an existing project  
• Open recently opened 

Projects 
• Open an existing project from 

DIAStudio web  
• Close project  
• Save project  
• Save-as project  
• Save project to DIAStudio  
• Exit project  

 

 
 

View menu allows to display or hide  
• Selection View  
• Project View  
• Compare Product  
• Bill of Material  
• Properties  
• Filters  
• Product Search  
• System  

 

 
 

Option menu allows to access  
• Language: Select the 

required language from the 
list of languages.  
o English  
o Traditional Chinese  
o Simplified Chinese  

• Update Product Database: 
Updates the product 
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Menu Name 

database. For more 
information, refer 2.2 Product 
Database Update.  

• LAN Settings: Allows to 
configure the proxy server 
settings 

 

 
 

Help menu allows to access  
• DIASelector manual  
• Technical Support: Creates 

a support ticket.  
• About : Displays the details 

of the software. 
 

 

3.3 Quick Access Toolbar 
 

The Quick access tool bar displays the tool bar options, 
 

Toolbar Icon Description 

 
 

Create a new project (Ctrl+N)  

 
 

Open an existing project (Ctrl+O)  

 

 
 

Open the project from DIAStudio 
web 



Chapter 3                                                                                       DIASelector 

17 
 

Toolbar Icon Description 

 
 

Save project (Ctrl+S)  

 
Save project as  

 
 

Save Project to DIAStudio Web  

 
 

Close Project (Ctrl+W) 

 
 

Compare products  

 
 

Opens Bill Of Materials window  

 

 
 

RIO Communication protocol 
selection. 
 
CANopen: Select CANopen protocol 
for RIO. 
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Toolbar Icon Description 

EtherNet/IP: Select Ethernet/IP 
protocol for RIO. 
 
NOTE: CANopen is selected by 
default, when Hardware 
Configuration is opened. 

 
 

Helps to Hide/display the Legends  
(NOTE: Applicable only for 
Hardware Configuration)  

 

Open Servo Sizing window 

 

 



Chapter 4                                                                                       DIASelector 

19 
 

Chapter 4: Project Creation 
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4.1 Add Project 
 

Users can Create Project, Create Group in Project & add Products to Groups.  

Follow the steps to create a project:  

1. Create a new Project.  

Follow any one of the method to create a new project:  

• In the File Menu, Click on File > New Project.  

           Or 

• In the Quick access toolbar, click on   icon. 

 

 

Figure 4 - 1: Add Project 

 

2. Enter a project name. 

3. Browse a location to save the project. 

4. Select a region. This allows user to access products available to a 

particular region.  

5. Enter description (optional) and click on OK button.  

Result: Displays the Project View as shown in the figure. 
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Figure 4 - 2: Project View 

 

NOTE: 

• It is mandatory to select a Region to create a project.  

• If user has not logged-in into the DIASelector application, by default 

Global is displayed in the Region field.  

• If user has logged-in, then, user’s region information is retrieved from 

the database and the default region is set accordingly. User can 

change the default region.  

• Once the project is created, user cannot change the region for that 

project.  

• If user selects a particular region, the region specific products are 

displayed for selection, beside globally available products.  

 

Adding Products 

 

User can add products to the Project View in multiple ways. Following are the 

different options: 



Chapter 4                                                                                       DIASelector 

22 
 

 

• Selection View (refer 5.2 Select Page) 

• Compare Product (refer 5.3 Product) 

• Product Search (refer 5.5 Product Search) 

 

4.2 Creating a Group 
 

Based on the application type, user can create different Groups: 

• General Application – Allows user to select a product manually from 

the Selection View.  

• Motion Control Application – Allows user to select Motion Control 

Products from the Selection View.  

• Custom Generated Application – Allows user to enter their 

requirements and specifications to get suitable PLC/AC Motor Drives.  

 

Follow the steps to create a group: 

1. Click on  Add Group icon in the Project View.  

Result: Displays the Add Group window as shown in the figure. 

 



Chapter 4                                                                                       DIASelector 

23 
 

 

Figure 4 - 3: Add Group 

 

2. Enter a group name.  

3. Select an application profile.  

4. Select the required communication protocol.  

NOTE: By default, all the communication protocols are checked. 

Uncheck the protocols to deselect it. If a protocol is checked, then the 

products supporting this protocol will be displayed in the Selection 

View. 

5. Click on OK button.  

Result: A Group is created in the Project View. 

 

4.3 Project View Context Menu 
 

4.3.1 Group Context Menu 
 

To open the Group context menu, right-click on Group. The group context 

menu is as shown in the figure. 
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Figure 4 - 4: Group Context Menu 

 

The Group context menu functions are described as follows: 

 

Function Description 

Network View Open network view tab 

Rename Group Allows to rename a Group.  

Delete Group Allows to delete a Group 

 

 

4.3.2 Product Context Menu 
 

Right-click on a product to open its context menu. An example of PLC product 

context menu is shown in the figure 
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Figure 4 - 5: Product Context Menu 

 

Functions in context menu of PLC e.g: AS200 / AS300 is described in the 

table: 

 

Name Description 

Hardware Configuration Opens Hardware Configuration 
tab. 

Configuration Wizard Opens Pre-Selected Controller 
Configuration tab. 

Delete Device Allows to delete a device. 

Add Accessories Opens Accessory Selection tab. 

 

NOTE: The product context menu items vary depending on the product. For 

example, DOP series Touch Panel HMI has only Delete Device option. 
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4.4 Open DIAStudio Web 
 

4.4.1 My Files 
 

This function allows user to open the files saved in the DIAStudio cloud 

storage and also files shared to their account. To access this feature, click 

File > Open from DIAStudio Web or click . 

 

 

Figure 4 - 6: Open Project from DIAStudio Web 

 

User can view the list of projects saved in the cloud and also can share the 

file with other users in DIAStudio Cloud. Select the required project and click 

on Open button to open the project. 

NOTE:  

• User must sign in for this feature. 

• If user has signed in, this window will display.  
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• If user has not signed in, the pop-up window displays the sign in page. 

 

Follow the procedure to share the project with other registered DIAStudio 

users: 

1. Select the project from My files list.  

2. Enter the e-mail ID of recipient. 

3. Click on Share button.  

Result: A confirmation message appears at bottom-left corner. If the 

user is registered, his/ her first name and last name is displayed. 

 
4.4.2 Shared with me 
 

 

Figure 4 - 7: Shared with me 

 

This function allows user to access the files shared by other users with the 

present user. Select the project and click on Open button to open the shared 

project. 
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4.5 LAN Settings 
 

In case, the network in which DIASelector is running is using a proxy server, 

follow the procedure to configure to the proxy server settings. 

1. Click on Option > LAN Settings as shown in the figure. 

 

 

Figure 4 - 8: LAN Settings 

 

Result: Displays the LAN Settings window as shown in the figure 

 

 

Figure 4 - 9: LAN Settings Window 

 

2. Enter the Network Username and Password.  

3. Select the proxy server check box.  
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4. Enter the address and port. 

5. Click on OK button. 
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Chapter 5: Product Selection 
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5.1 Introduction 
 

Selection feature facilitates user to select products from:  

• Selection View 

• Compare Products  

• Product Search 

 

5.2 Select Page 
 

When a Group is created with General Application or Motion Control 

Application or when a Group (other than Custom Generated) is clicked in 

Project View, the Selection View window displays. 

 

 

Figure 5 - 1: Selection View 

 

Legends Name 

1 Product Category 

2 Product Family 

3 Product Series 
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Legends Name 

4 Product List 

 

Follow the procedure to add products to the Group from the Selection View. 

1. In the Selection View, click on the required Product Category > 
Product Family > Product Series.  

2. In the Product List, click on  icon.  

3. Repeat the steps, to add required products to the Groups in the  

Project View as shown in the figure.  

 

 

Figure 5 - 2: Add Products 

 

Features 

 

The following table represents the Selection View icons and its description. 
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Icon Description 

 Click to download the product catalog. 

 
Click to open the product catalog in PDF. If the file 
is already downloaded, it opens in PDF. If it is not 
downloaded, it opens in default browser.  

 Click to add the selected product to the group. 

 

Click to select the product for property comparison 
in Compare Product feature.  
NOTE: Select 2 or more products for comparison & 
click <Compare> icon from the quick access 
toolbar. 

 

5.3 Product Comparison 
 

The Compare Product feature helps user to compare multiple products of 

same family or series based on the properties. 

The Compare Product window can be accessed by menu bar, click View > 
Compare Product. 

NOTE: Maximum of 4 products can be compared at a time.  

An example of product comparison is shown in the figure. 
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Figure 5 - 3: Compare Product Window 

 

There are two ways to compare the products:  

• Select the products to be compared from Selection View window and 

open Compare Product window. (Selection View > Comparison).  

or 

• Open Compare Product window and select products to be compared.  

 

5.3.1 Selection View > Compare Products 
 

Follow the steps to compare the products through Selection View window:  

1. In the Selection View, click on the required Product Category > 
Product Family > Product Series.  

2. In the Product List, click on   check box to select the 

products to compare. 

3. Repeat the steps to compare up to four products.  
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4. Click on  icon in the quick access tool bar.  

Result: Displays the Compare Product window as shown in the 

figure. Difference in the results are highlighted. 

 

 

Figure 5 - 4: Compare Product Results 

 

5. Click on  icon next to the products to add required products to the 

selected Group. 

 

5.3.2 Compare Product > Select products to be compared 
 

This feature helps user to compare the products by opening the Compare 
Product window and then select the products to be compared. 

Follow the steps to open Compare Product window and then select the 

products: 

1. Click on View > Compare Product.  

Result: Displays Compare Product window as shown in the figure. 
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Figure 5 - 5: Compare Product 

 
2. Select the required Product Family, Product Series from respective 

drop-down lists.  

NOTE: The Module Type is  available only for the PLC products such 

as CPU, Digital Input and so on. 

3. Select products from the drop-down list to compare as shown in the 

figure.  

An example with Product Family: PLC; Product Series: DVP-SS2; 

Module Type: CPU is shown in the figure. 
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Figure 5 - 6: Compare Product -Product Selection 

 

4. Repeat the procedure for up to 4 products.  

Result: The Compare Product window is displayed with the property 

comparison of products. 

5. Click on  icon next to the products to add required products to the 

Group. 

 

5.4 Properties 
 

The Properties feature displays the properties of the selected product. Click 

on a product in the Selection View window, and open the Properties window 

to view the properties of that product. 

Properties window is displayed by default while launching DIASelector 

application. Properties feature is also accessible through View > Properties. 

The properties are classified into the following: 

• General  

• Electrical  

• Mechanical  
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• Communication 

 

Property names depend upon the product family selected and it varies from 

one family to another. An example of DVP12SS211S is shown in the figure. 

 

 

Figure 5 - 7: Properties 

 

5.5 Product Search 
 

The Product Search feature helps user to search a particular product from 

multiple product families and series. User can add the products shown in the 

search results to the Project View. 

The Product Search window is displayed by default while launching 

DIASelector application. 

The Product Search feature is also accessible through View > Product 
Search. 
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Figure 5 - 8: Product Search Window 

 

The Product Search window displays the following fields: 

 

Function Description 

Search Enter the text to be searched. 

Criteria Select the search criteria. 

Product Family Select the product family. 

 

Products can be searched by following methods: 

• Part Number Search 

• Guided Part Number Search  

• Description  
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5.5.1 Part Number Search 
 

The Part Number Search feature allows user to search a particular part 

number by entering the keywords of the product. 

When a Product Search window is opened, Part Number Search option is 

selected by default in the Criteria field. By default, All is selected in the 

Product Family field. User can add products from the search results to the 

Group in the Project View. 

Follow the steps to perform a Part Number Search: 

1. Open Product Search window.  

2. Enter the part number or few characters of the product to be searched.  

NOTE: The search text field is not case sensitive.  

3. Select the respective Product Family to narrow down the search 

results. (This step is optional).  

Result: The Product Search window displays the search result.  

An example of Part Number Search with search text TP and Product 
Family selected as All is shown in figure. 
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Figure 5 - 9: Part Number Search with Product Family 

 

4. Click on  add icon to add products to the Group in the Project View.  

NOTE: Search result is displayed with family name, part number 

description and detailed property of the product. It also shows the 

option to add  products to the group. 

 

5.5.2 Guided Part Number Search 
 

The Guided Part Number Search allows user to search particular products 

by entering characters of that product series, wherever applicable. The 

pattern of part number is provided in the text field where the characters 

representing properties are displayed with a question mark (?) and asterisk 

(*). The static texts throughout the product’s part number in that product 

series will be kept as it is. An example of pattern is DVP??SS211?. 
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Follow the steps to perform a Guided Part Number Search: 

1. Open Product Search window. 

2. Select Guided Part Number Search in the drop-down list in Criteria 

field. 

3. Select the required product family from the Product Family drop-down 

list.  

4. Select the required product series from the Product Series drop-down 

list.  

Result: Based on the product family and product series selected, the 

search text field is displayed. 

The example of the text pattern according to the selection is as shown 

in the figure. 

 

 

Figure 5 - 10: Guided Part Number Search 

 

5. Click on  icon to view the pattern description. It helps to understand 
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the nomenclature of particular pattern.  

 

 

Figure 5 - 11: Pattern Search Image 

 

6. Enter required character in ? in the search text field.  

Result: Search result is displayed with part number, description and an 

option  to add the products to the Group. 

An example of DVP-SS2 PLC pattern with search text as 

DVP??SS211? (where the last character is replaced with R – Relay) is 

as shown in figure. 
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Figure 5 - 12: Pattern Search Result 

 

7. Click on  icon to add that product to the Group in the Project View.  

 

5.5.3 Description 
 

In the Product Search, users can search the product by selecting description 

in the Criteria field. 

Follow the steps to perform Product Search using description:  

1. Open Product Search window.  

2. Select Description option in the drop-down list in Criteria field.  

3. Enter few characters in the search.  

Result: The Product Search window displays the search results. 

An example of product search with input Criteria: Description; Search: 
16k; Product Family; PLC is shown in the figure. 

 



Chapter 5                                                                                       DIASelector 

45 
 

 

Figure 5 - 13: Product Search Description 

 

NOTE: When a Product Family is selected, search functionality 

narrows down the product search to that particular family. Search result 

is displayed with family name, part number, description, detailed 

property and with the option to add the products to the Group. 

4. Click on icon to add product to the Group in the Project View.  

 

5.6 Filters 
 

The Filters feature allows user to filter the products based on specific 

properties. Filters window is displayed by default when DIASelector 

application is launched. Filters feature is also accessible through View > 
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Filters. Select the check box / radio buttons in the respective filter property to 

filter the products. 

 

 

Figure 5 - 14: Filters 

 

The Reset button helps to clear the user selection. 

NOTE: The content of the Selection View i.e. the products in individual series 

changes as per the filters applied for the product type. 

 

An example of PLC with filter applied is as shown in the figure. 
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Figure 5 - 15: Filter Property applied for PLC 
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Chapter 6: Configuration - PLC/AC Motor 
Drives/Servo Sizing 
  



Chapter 6                                                                                       DIASelector 

49 
 

6.1 Introduction to Configuration 
 

The Configuration feature allows user to configure PLC, AC Motor Drives and 

AC Servo Drives. Based on the properties selected, PLC / AC Motor Drive / 

AC Servo Drives/AC Servo Motors is selected. 

 

6.2 Controller Configuration 
 

Controller Configuration can be done in two ways: 

• Custom Generated Application  

• Pre-Selected Controller Configuration  

 

6.2.1 Custom Generated Application - PLC (Controller) 
 

The Custom Generated Application helps user to create a PLC configuration 

with CPU, Power Supply, Network modules, Remote Input Output modules 

and so on. To perform Custom Generated Controller configuration, user must 

create a Custom Generated Application Group in the Project View. 

Follow the steps to create Custom Generated PLC Configuration: 

1. Click on   icon in the Project View.  

2. Select Custom Generated Application in the Application drop-down 

list as shown in the figure.  
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Figure 6 - 1: Custom Generated Application 

 

NOTE: By default, all the protocols are checked.  

3. Click on OK button.  

Result: The Application Selection window is displayed as shown in 

the figure. 

 

 

Figure 6 - 2: Application Selection Window 

 
4. Click Configure in Controller section. 

Result: The Controller Configuration window will be displayed as 
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shown in the figure. User is guided to controller configuration in a 

series of 3 tabs: 

• Initial Configuration (default tab)  

• RIO Configuration  

• Controller Selection.  

 

 

Figure 6 - 3: Controller Configuration - Initial Configuration 

 

5. Select the required properties in the Initial Configuration tab and click 

on Next button.  

 

NOTE:  

• User can select Modular / Non-Modular PLC and then select.  

• Power Supply  

• Program Capacity  
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• Output Method  

• Redundancy  

• Built-in IO  

• Number of Expansion Racks and so on.  

 

For Local Rack/Expansion, enter the number of  

• Digital Output  

• Analog Input  

• Analog output  

• Thermocouple  

• RTD  

• Load Cell Points (Channels) 

 

NOTE1: By default, the Mixed IO points, DIO and AIO are selected. If 

both are checked in, Controller Configuration wizard considers the 

mixed IO modules. If user uncheck, it will consider individual Digital or 

Analog modules. 

 

NOTE2: User can also enter the requirement of Pulse Input points and 

Frequency needed as per application requirement. For Pulse Output, 2 

options are available, that is Normal Pulse or Communication. 

 



Chapter 6                                                                                       DIASelector 

53 
 

  

Figure 6 - 4: Controller Configuration - RIO Configuration 

 

6. Select the RIO Communication Protocol and number of Remote I/O 

Station(s) in the RIO Configuration tab as shown in the figure.  

Enter the number of Digital Input, Digital Output, Analog Input, Analog 

Output, Thermocouple and RTD points needed in every RIO Station. 

 

 

Figure 6 - 5: Controller Configuration - RIO Configuration Example 
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7. Click on Next button to proceed to Controller Selection tab.  

Result: The Controller Selection tab displays the recommended PLC 

Configurations based on the User’s requirement. The slots are 

displayed as per the PLC configuration and description is also provided 

as shown in the figure. 

User can select among the different possible options of controller 

configurations suggested. Controller Selection tab also suggests 

mandatory accessory which is needed for particular modules. 

 

  

Figure 6 - 6: Controller Configuration - Controller Selection 

 

8. Select the radio button in Select column to pick the appropriate PLC 

Configuration and click on Finish button.  

Result: Selected configuration is displayed in the Application 
Selection window with mandatory accessories if any as shown in the 

figure. 
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Figure 6 - 7: Controller Configuration - Accessory Selection 

 

9. Add Accessory Type, Part Number and select number of part according 

to the requirement as shown in the figure.  

NOTE: Click on  icon to add additional accessory to the controller. 

Click on icon to delete the accessory. Click on  to view the image 

of the accessory. The mandatory accessories cannot be deleted by 

user. Optional accessories can be added or deleted. 

 

 

 

Figure 6 - 8: Application Selection 

 

10. Click on OK button in the Application Selection window.  



Chapter 6                                                                                       DIASelector 

56 
 

Result: Selected Controller and its configuration is added to the 

Custom Generated Application Group in Project View as shown in 

the figure. 

 

 

Figure 6 - 9: Controller Configuration - Selection added to Group 

 

6.2.2 Pre-Selected Controller Configuration Wizard - PLC (Controller) 
 

The Pre-Selected Controller Configuration wizard allows user to configure the 

components of a PLC after selecting a particular CPU in a Group.  

Follow the steps to configure the PLC using Pre-Selected Controller 

Configuration Wizard: 

1. Add a PLC to the Group from the Selection View.  

2. Select the PLC to be configured and right-click to open the context 
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menu. 

Result: Displays the context menu as shown in the figure. 

 

 

Figure 6 - 10: PLC - Context Menu 

 

3. Click on Configuration Wizard. 

Result: User is guided through controller configuration in a series of 3 

tabs:  

• Initial Configuration  

• RIO Configuration  

• Controller Selection  
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Figure 6 - 11: Pre–Selected Configuration Wizard - Initial Configuration 

 

NOTE: By default, the Mixed IO points, DIO and AIO are selected. If both are 

checked in, PLC Configuration wizard considers the mixed IO modules. If user 

uncheck, it will consider individual Digital or Analog modules. 

 

NOTE: Some of the properties are grayed out in the Pre-Selected Controller 
Configuration window. 

Further process is similar to that of PLC Configuration as explained in 6.2.1 

Custom Generated Application - PLC (Controller) Depending on the 

properties of the CPU selected, the specifications are supported. 

In the Controller Selection tab, a suitable Controller and its configuration can 

be selected and added to the Group. 
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6.3 AC Motor Drive Configuration 
 

The AC Motor Drive Configuration feature helps user to select a AC Motor 

Drive based on the Motor Type, Motor Voltage, Motor Current, Line Voltage, 

Line Current, Line Frequency, Control method, Switching Frequency, IO 

requirements, PG Card and so on. 

Follow the procedure to configure Custom Generated AC Motor Drive: 

1. Click icon in the Project View.  

2. Select Custom Generated Application from the Application drop-

down list as shown in the figure.  

 

 

Figure 6 - 12: Custom Generated Application 

 

3. Select required communication protocols.  

NOTE: By default, all the protocols are checked. 

4. Click on OK button.  

Result: The Application Selection window is displayed as shown in 

the figure. Following products are supported in configuration:  
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• Controller  

• AC Motor Drive 

 

 

Figure 6 - 13: Configuration of Application Selection 

 

5. Click Configure button in AC Motor Drive section.  

Result: Displays AC Motor Drive Configuration window. User is 

guided for AC Motor Drive configuration in a series of 6 tabs: 

• Load Type Setting 

• Motor Specification  

• Drive General Specification 

• Drive IO Specification  

• Control Mode 

• AC Motor Drive Selection 

 
6. In the Load Type Setting tab, user can enter the Load Type, in 

Environment select Ambient, Application and Enclosure style related 

requirements as shown in the figure.  
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Figure 6 - 14: AC Motor Drive Configuration - Load Type Setting 

 

7. Click on Next button to proceed to the Motor Specification tab.  

8. In the Motor Specification tab, user can enter the specifications of 

motor as shown in the figure. 

 

Figure 6 - 15: AC Motor Drive Configuration - Motor Specification 
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9. Click on Next button to proceed to the Drive General Specification 

tab.  

10. In the Drive General Specification tab, user can enter the general 

specifications related to the AC Motor Drives as shown in the figure.  

 

 

Figure 6 - 16: AC Motor Drive Configuration - Drive General Specification 

 

11. Click on Next button to proceed to the Drive I/O Specification tab.  

12. In Drive IO Specification tab, user can select the Input Output 

requirements for Discrete, Analog and Pulse Train signals along with 

STO functionality as shown in the figure.  
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Figure 6 - 17: AC Motor Drive Configuration - Drive IO Specification 

 

13. Click on Next button to proceed to Control Mode tab.  

14. In Control Mode tab, user can select PG Card related parameters as 

shown in the figure.  

 

Figure 6 - 18: AC Motor Drive Configuration – Control Mode 
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15. Click Next to proceed to AC Motor Drive Selection tab.  

16. In AC Motor Drive Selection tab, user can select an AC Motor Drive 

from the set of options suggested by DIASelector as shown in the 

figure.  

 

 

Figure 6 - 19: AC Motor Drive Configuration – AC Motor Drive Selection 

 

17. Click on Finish button to add the AC Motor Drive and Accessories to 

the Application Selection window as shown in the figure.  
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Figure 6 - 20: AC Motor Drive Configuration - Application Selection 

 

NOTE: Click on  icon to add additional accessory to the AC Motor 

Drive. Click on icon to delete the accessory. Click on  to view the 

image of the accessory. The mandatory accessories cannot be deleted 

by user. Optional accessories can be added or deleted. 

If required, user can add multiple drives in the window. Click on  

icon next to the AC Motor Drive to configure additional drives to the 

Application Selection window. 
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Figure 6 - 21: AC Motor Drive Configuration - Adding optional 
Accessories 

 
18. Click on OK button to add drives to the Group folder in the Project 

View.  

 

6.3.1 Adding Accessories to AC Motor Drive 
 

User can add recommended accessories to selected AC Motor drives in the 

Project View. Follow the procedure to add Accessories to the AC Motor 

Drive. 

1. Create Project and add AC Motor Drives to the Project View.  

2. Right-click on the AC Motor Drive to open the context menu and click 

on Add Accessories as shown in the figure.  
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Figure 6 - 22: AC Motor Drive - Adding Accessory 

 

Result: The Accessory Selection window displays as shown in the 

figure. 

 

Figure 6 - 23: AC Motor Drive – Accessory Selection 

3. Add the accessory type, part number and number of parts required as 

shown in the figure.  
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Figure 6 - 24: AC Motor Drive - Accessory Selection Window 

 

4. Click on  icon to add more accessory to the device as shown in the 

figure.  

 

Figure 6 - 25:  Adding Accessories to AC Motor Drive 

5. The AC motor drives and their accessories are added to the Project 
View as shown in the figure.  
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Figure 6 - 26: AC Motor Drive and Accessories 
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6.4 Servo sizing 
 

Servo Sizing helps users to select a AC servo motor, AC servo drives and 

accessories based on the mechanism and motion profile selected by the user. 

Follow the procedure to perform Servo Sizing: 

1. Create a Group in the Project View. 

2. With the above Group selected, click  icon on the toolbar. 

Result: The Servo Sizing window displays as shown in the figure with 

Mechanism Selection tab displayed by default. 

 

 

Figure 6 - 27: Servo Sizing window 

 

3. Select a mechanism and click Next. 

4. Select/enter parameters according to user needs for Servo selection: 
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• Connector Selection 

Choose Coupling/Gear/Belt according to user’s requirement. 

NOTE: The image of mechanism displayed in the Connector 
Selection tab depends upon the mechanism selected. 

 

 

Figure 6 - 28: Connector Selection window 

 

• Mechanism Parameters 

Fill in the relevant values as per user requirements, and then click 

Calculate, the system will automatically calculate the results as 

shown in the Mechanism parameters tab. 

The Mechanism Parameters tab displays the parameters as per 

the mechanism selected 
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Figure 6 - 29: Mechanism Parameters – Trolley 

 

 

Figure 6 - 30: Mechanism Parameters – Rotary Table 
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Figure 6 - 31: Mechanism Parameters – Roller Device  

 

 

Figure 6 - 32: Mechanism Parameters - Ball Screw  
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Figure 6 - 33: Mechanism Parameters - Rack & Pinion  

 

 

Figure 6 - 34: Mechanism Parameters - Conveyor 
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• Motion Profile 

The system will display the set motion waves after filling in the 

relevant values as shown in the figure. 

 

  

Figure 6 - 35: Motion Profile window 

 

• Motor Selection 

The Motor Selection tab displays the Calculation Result, 
Calculation Process, list of AC Servo Motors which meet the 

requirements and the Filter properties to filter AC Servo Motors 

based on user requirements. 

After filling in the relevant values in Filter Parameters, the specific 

AC servo motors are displayed at the bottom of the window. 

NOTE: User can also select multiple motors and click Compare. 

The comparison window will appear (Figure 6-35) 
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Figure 6 - 36: Motor Selection window 

 

  

Figure 6 - 37: AC Servo Motors Comparison window 

 

• Drive Accessory Selection 

System displays the supported AC servo drives list based on the 

AC servo motor selected. User can select the AC servo drives from 
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the Drive selection. Select the Accessory from the drop-down list 

,then click  to add or remove the accessories (Figure 6-38). 

There is a Generate Report function on the bottom-right to 

generate .txt file (Figure 6-37). 

 

  

Figure 6 - 38: Drive Accessory Selection window 

 

 

Figure 6 - 39: Accessory Selection 

 

5. Click Finish in the Drive Accessory Selection tab. 

Result: AC Servo Motor, AC Servo Drives and Accessories are added 

to the Project View. 
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Figure 6 - 40: Project View after Sizing 

 

6.5 Accessory Recommendation 
 

Users can select the accessories of PLC / AC Motor Drives / AC Servo Drives 

in Project View. In case of PLC, different modules like CPU, Digital Input, 

Digital Output, Pulse modules etc. support addition of accessory from Project 
View.  

Follow the steps to add Accessories to a PLC / AC Motor Drives / Servo: 

1. Right-click on the product. 

Result: Context menu of the product displays as shown in the figure. 

 

 

Figure 6 - 41: Context menu 

 

2. Click Add Accessories. 

Result: Accessory Selection window displays as shown in the figure. 
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Figure 6 - 42: Adding Accessories to Module 

 

3. Click the Accessory type, and select the required accessory in Part 

Number, enter the number of accessory required, Click  to view the 

image of the accessory. Click  to add more accessory as per user’s 

requirement. Click  to delete an accessory. Click OK.  

An example of Accessory Image is shown in the figure, 
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Figure 6 - 43: Accessory image 

 

Result: Accessories are added to the Project View as shown below. 

 

 

Figure 6 - 44: Accessories added to Project tree 

 

4. In case of PLC, Accessories for non-CPU modules are added as 

mentioned above: 

Example: Select the module in Project View, right-click to open 

context menu and click Add Accessories as shown in the figure. 
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Figure 6 - 45: Accessories added to Non CPU modules 

 

Result: The Accessory Selection window displays in which users can 

select the accessories in the similar way like PLC/AC Motor Drives. 
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Chapter 7: Hardware Configuration 
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7.1 Introduction 
 

DIASelector can create a hardware configuration and make Bill Of Material 

(BOM) out of the configuration. The Hardware Configuration displays the slots 

of modules in a PLC Controller configuration.  

A PLC configuration consists of several modules like Power Supply module, 

I/O modules, Network modules, Pulse IO modules, Backplane and so on. 

These modules are arranged on dedicated slots / positions based on the 

modular and non-modular configurations, which can be viewed in the 

Hardware Configuration. 

 

NOTE: As of current, only AS (AS200/AS300) PLC can be configured in 

Hardware Configuration in DIASelector V1.0. 

 

 

7.2 Creating Hardware Configuration 
 

Follow the steps to create a Hardware Configuration:  

1. Select a Group. 

2. Add a AS200/300 PLC CPU to the Group from the Selection View. 

3. Right-click on the CPU and click on Hardware Configuration from the 

context menu as shown in the figure.  
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Figure 7 - 1: Hardware Configuration 

 

Result: The Hardware Configuration window is displayed as shown 

in the figure. 

 

 

Figure 7 - 2: Hardware Configuration - Legends 

 

Legend Name 

1 Power Supply 

2 CPU 

3 Place to add IO modules (DIO, AIO), network modules (NIO) 
and Pulse Input-Output modules (PIO).  
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Legend Name 

 

4 Place to add RIO 

 

The Hardware Configuration window displays CPU with:  

• a Power Supply module on left of CPU.  

• click   on the right of CPU  to add IO modules (DIO, AIO), 

network modules (NIO) and Pulse Input-Output modules (PIO).  

• Click  below the CPU  to add RIO.  

 

4. Select the RIO network. Select either CANopen or EtherNet/IP 

  icon in the Quick access tool bar.  

 

NOTE: CANopen is the default RIO communication protocol. 
 

5. Double-click on the slot  next to the CPU.  

Result: The Module List pop-up window is displayed as shown in the 

figure. Module List pop-up displays DIO, AIO, NIO and PIO for CPU 

Local Extension. 
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Figure 7 - 3: Hardware Configuration - Module List 

 

6. To add module to the Hardware Configuration, either double-click on 

the required module in the Module List or drag-drop required module 

to the slot. 

User can also search the required product in the Search Toolbox field. 

 

 

Figure 7 - 4: Hardware Configuration - Module Insertion 
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Result: Module(s) are added into the Hardware Configuration as 

shown in the figure. 

 

 

Figure 7 - 5: Hardware View - New Module 

 
7. Double-click on  icon below the CPU.  

Result: RIO drop is created with CANopen protocol by default. Once 

an RIO is created, a connection line is created between the SCM 

module of the RIO rack and CPU module automatically. 

A new spaceholder  for another RIO creation is shown below the 

new RIO drop as shown in the figure. 
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Figure 7 - 6: Hardware Configuration - RIO Creation 

 

NOTE: To create RIO configuration over EtherNet/IP, click on  . Add 

required IO modules in the Hardware Configuration.  

NOTE: Refer Hardware Manual for further information on IO modules. 

When the modules are added in the Hardware Configuration, the Project 

View is updated automatically as shown in the figure. 
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Figure 7 - 7: Modules added to Project View 

 

NOTE: 

Legends:  

The icon provides the option to hide/display the details of the products 

in the Hardware Configuration. 

 

 

Figure 7 - 8: Legend Icons – Hide/show details 

 

CANOpen:  

Click on the  and select CANopen to open the CANopen network. The 

CANopen network is represented by green color as shown in the figure. 
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Figure 7 - 9: CANopen Icon – Select CANopen network 

 

Ethernet/IP:  

Click on the  and select EtherNet/IP to open the the Ethernet network. 

The Ethernet network is represented by red color as shown in the figure. 

 

 

Figure 7 - 10: Ethernet/IP Icon – Select Ethernet network 

 

7.2.1 Hardware Configuration Context Menu 
 

 

Figure 7 - 11: Hardware Configuration - Context Menu 
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Function Description 

Set Function Card Allows to set Function Card (AS300 
CPU). 

Replace Module Allows to replace a module. 

Cut Allows to cut a module. 

Copy Allows to copy a module. 

Paste Allows to paste a module. 

Delete Allows to delete a module. 

 

7.2.1.1 Function Card Setting 
 

For AS300 CPUs, Slot 1 and Slot 2 are available for insertion of Function 

cards. 

Follow the procedure to insert Function cards in Slot 1/Slot 2: 

1. Click Set Function Card option from the context menu as shown in the 

figure.  

 

 

Figure 7 - 12: Hardware Configuration - CPU Context Menu 

 

Result: Displays Function Card Setting window. 

2. Select the required Function card for Slot 1/Slot 2 as shown in the 

figure.  
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Figure 7 - 13: Function Card Setting Window 

 

3. Click on OK button.  

Result: The selected function cards are inserted in the CPU as shown 

in the figure. 
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Figure 7 - 14: CPU with Function Card inserted 
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Chapter 8: Bill of Materials (BOM) 
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8.1 Introduction 
 

The DIASelector application allows user to create project and generate BOM. 

The user can save the BOM report and e-mail it. 

The BOM report can also be exported to different formats such as MS-Word 

(97 ~ 2003) and MS-Excel (97 ~ 2003). 

 

8.2 Generate BOM Report 
 

Follow the steps to generate the BOM report: 

1. Create a Project with devices.  

2. Click on View > Bill of Materials.  

Or 

Click  in the Quick Access tool bar.  

Result: Displays the Bill Of Materials window as shown in the figure. 

 

 

Figure 8 - 1: BOM 
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The Bill Of Materials window is displayed with Name, Description and 

Quantity fields. Products are segregated as per Groups created in the 

Project View. User can edit the Quantity of Products based on the 

requirements. 

 

8.2.1 E-mail BOM Report 
 

User can e-mail the BOM report. Click  icon in the Bill Of Materials 

window. The Bill of Materials e-mail window is displays as shown in the 

figure. Enter the required details and click on Send button to send the e-mail. 

 

 

Figure 8 - 2: E-mail BOM 

 



Chapter 8                                                                                       DIASelector 

97 
 

Function Description 

To 

Enter the email address of recipient. 
NOTE: If the User is signed in, it 
automatically displays the e-mail ID in 
the To field. 

Send As Select the required format, word or 
excel.  

Subject Subject cannot be edited. 

Send Click to send mail. 

 

8.2.2 Save BOM Report 
 

User can save BOM report. Click  icon in the Bill Of Materials window to 

save the BOM report. 

NOTE: Default format is MS-Word. Select Excel option in the Save as type 
field to save in Excel format. 

 



Chapter 8                                                                                       DIASelector 

98 
 

 

Figure 8 - 3: BOM in MS-Word 

 

8.2.3 Updating the DIAStudio Account 
 

To display the information in BOM report, user must update the details in 

DIAStudio account. 

Follow the procedure to update the DIAStudio account. 

1. Login to DIAStudio website.  

2. Click on your login name > My Profile.  
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3. Enter the account information as shown in the figure. 

 

 

Figure 8 - 4: My Profile 

 

4. Upload the logo as shown in the figure.  
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Figure 8 - 5: My Profile – Upload Logo 

 

5. Click on Save button to update the account information.  

Result: The account information and logo is updated in the DIAStudio 

account. 
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Chapter 9: Network View 
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9.1 Introduction 
 

The Network View is a graphical representation of connections between 

devices that allows user to plan their Networks. (The Network View in 

DIAselector is a basic version of the network view available with DIADesigner 

application.) Network View option is available in the context menu of every 

Group in DIASelector.  

 

 

Figure 9 - 1:Group right-click menu 

 

9.2 Network View Description 
 

The Network View displays two types of information: 

• Device information 

• Network information 
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9.2.1 Device Information 
 

 

Figure 9 - 2: Network View - Device Information 

 
Device information includes: 

• Device image 

• Device name (Part number) 

• Communication ports on the device with protocol support. 

NOTE: For control devices, the communication port are displayed below 

the product image (a sample is shown in Figure 9 - 5: Network View  and 

for other devices, communication ports are displayed above the product 

image.  
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9.2.2 Network Information 
 

 

 

Figure 9 - 3: Network View - Network Information 

 

Network information includes: 

• Name of the Network 

• Network lines with Colors 

• Connections to the Devices 

 

9.3 Creating Network View 
 

The Network View is a schematic description of network arrangement, 

connecting various devices and networks in the project. It helps user to 

understand and arrange the devices and networks in a layout or for an original 

equipment manufacturer to display the communication network to the 
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customers or end user. User can connect to the Devices/Network, if they are 

of same Communication Protocol. 

If user wants to connect 2 devices to a new Network, instead of connecting 

them individually, they can connect the communication ports of same type 

which will create a new network of respective type.  

The control category devices like PLC, PAC and so on. will occupy the 

positions above the network lines and those like AC Motor Drivers, AC Servo 

Drives will occupy the positions below the network lines. 

Following table describes the colors used in Network representation: 

 

Fieldbus type Network Color 
EtherNet/IP Red 

MODBUS TCP Red 
MODBUS(RS-485) Blue 

CANopen Green 
 

Follow the steps to create a Network View:  

1. After adding products to a Group, right-click on Group and click on 

Network View from the context menu. 

 

 

Figure 9 - 4: Group context menu - Network View 
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Result: The Network View window is displayed as shown in the figure. 

 

 

Figure 9 - 5: Network View  

 

2. By default, dotted lines are displayed, user can create connections 

between the devices and networks. 

3. Click on a communication port and connect it to a dotted line. 

Result: Dotted lines change to a line with the same color as that of the 

device communication port (protocol) selected. 

4. User can also create connection between two devices by clicking and 

dragging from one device port to another. 

5. Connect the devices to the network through ports as shown in the 

figure. 
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Figure 9 - 6: Network View Connections 

 

NOTE: The visible dotted lines are for reference. Once the available network 

lines are connected, new dotted lines are created. 

NOTE: Some of the selected devices are not supported in Network View for 

current software version. ‘details' will be displayed now in the Network View. 

Products which are not supported will be displayed in the System tab. Click 

details to view the above items in System tab. 
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